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VECTOR > AXIS Camera Plug-in Configuration

1 Overview

From CANape 17, there is a plugin “Vector Axis Network Camera” available for AXIS camera to
compress the video stream with h264 compressor. In this way the size of the video data is efficiently
reduced. This document contains the instructions for how to configure the AXIS camera and how to
apply the camera plug-in in CANape.

2 Preparation

2.1  Turn off firewall of the computer

2.2 Set the IP address of AXIS F44 main unit

The factory default IP address of AXIS F44 main unit is 192.168.0.90. You can open the IP address in
your browser to configure the IP address as well as the cameras. The factory default user name and
password are both “root”.

Go to Basic Setup | 2 TCP/IP. Here you can change the IP address for your cameras.

AXI5a AXIS F44 Dual Audio Input Network Camera Live View | Setup | Help

- Basic Setup
Instructions
1 Users
2TCP/IP
3 Date & Time
» 4 Video Stream
» 5 Audio Settings

-

Video & Audio

-

Live View Config

-

Detectors

-

Applications

-

Events

-

Recordings

Languages

-

System Options

About

Basic TCP/IP Settings
MNetwork Settings
View current network settings:
IPv4 Address Configuration
Enable IPv4

_) Obtain IP address via DHCP
@ yse the following IP address:

IP =ddress: 192.168.0.91

Subnet mask: 235.255.255.0
Default router: 192.168.0.254

IPv6 Address Configuration

I:‘ Enable IPvE

Services
Enable ARP/Ping setting of IP Address
Enable AVHS
@ One-click enabled () Always
Procoy:
Proxy port: 3128
Proxy login:

Proxy password:

Proxy authentication method: @ Basic © Digest s

[ save ][ Resst |

A¥IS Internet Dynamic DNS Service

See also the advanced TCP/IP settings
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2.3 Change the IP address of network connection

The Ethernet adapter of your computer needs to be changed according to the IP address of F44 main
unit.
Internet Protocel Version 4 (TCP/IPvd) Properties ? =

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(7 Obtain an IP address automatically
(@) Use the following IP address:

IP address: 132,168 , 0 , 100
Subnet mask: 255.255.255. O
Default gateway:

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

[ OK H Cancel ]

3 Configure camera plug-in in CANape
3.1 Open CANape

3.2 Add new device — camera

ﬁl Ed Window
18- Start Display Devices Calibration Analysis Tools Logger
Hardware Interfaces
Symibol Explorer 1z (New)
3 an ~ m MNew Device
g | || ab® -
Name: |cam |
[ Explorer Search result
Comment: |
MNarne/type
» [g2 Devices
ECU i i
{2 Parameter set files CCP XCP WX1000 Diagnostic OBC
[® Measurements
[ Virtual measurement file chann... . :" T —— = oI
[y Statistics columns ICamera (with DirectShow DLL YCP Server | |
. - driver) or video files.
[£ Function definitions
Measurement list
5] Data Mining results Monitor CAN ETH FlexRay LIN
B Configuration (New) Q
& Window templates
2 Deleted windows
10 VectorlO N-DAQmx | | GPS Audio DAIC
& ES 6ixx SMB Signal
generator
Multimedia Camera or AVE
File
—
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3.3 Choose the source “Vector Axis Network Camera”

B Mew Device X
Name: |c:am
Comment: | |
Video
Source: | 1 Vector fas Network Camera v|
Audio
Please specify the video - -
and audio device settings. Source: |X~ Mo audio devics il |
Stream properties
Grabber
Preview:
Source not valid
Caution: Some later installed codecs may Direct X
make changes to the system, which affect - -
the function of DirectShow-based Diagnestics...
applications (such as CANape).
Back Mext Cancel Help

3.4 Click the “Video” above to configure the plug-in

T= Streaming Settings - O d

4 Connection

IP Address 192.168.3.91|
Port TCP/RTSP 554
Port UDP 50000

4 Miscellaneous

Camera Index

4 Userdata
Username root
Password root

4 Video Settings

Compressicn

Framerate 30
Resolution
Video Codec h264

Keyframe Interval

P Address

IP address of the camera (for example 192.168.0.90).

Refrezh OK Cancel
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The TCP port and UDP port range can be found in the web interface:

|v System Options |
» Secunty
Date & Time
» Metwork
~TCP/IP
Basic
SOCKS
QoS
SHMP
UPnp™
RTP
Bonjour
» Storage
» Ports & Devices
Maintenance
» Support
» Advanced

About

RSP |

RTSP port: 554

Host Name Configuration

axis-acccBeas8hz

@ Use the host name:

D Enzble dynamic DNS updates
Register NS name: (Axisproduct.example.com)
TTL:

Link-Local IPv4 Address

Auto-Configure Link-Local Address View

HTTP

HTTP port:

HTTPS

HTTRS port: 443

MAT traversal {port mapping) for IPv4

L
[=]

MAT trawversal is disabled.

D Use manually selected MAT router: \:I (L&M IP address)

Alternative HTTR port:

ﬂ

" If set to blank or 0, a port number will be set automatically upon enable.

FTP

Enabls CTD comyer

Enable RTSP servar

Save H Reszet ]

AE AT

+ Basic Setup

» Video & Audio

+ Live View Config
+ Detectors

+ Applications

+ Events

+ Recordings

Languages

|v System Options
» SECUTTY
Date & Time
- Metwork
»yTCR/IP
SOCKS
Qos
SNMP

Epp ™™

Bonjour
» Storage
» Ports & Devices

AXISa AXIS F44 Dual Audio Input Network Camera Live View | Setup | Help

RTP Settings (9]
Port Range
Start port: [1024..65534]

End port: 50959 [1025..65535]
Multicast
Camera 1

239.235.152.17%

Video paort: D [0, 1024..65534; even values only]”

239.235,152.51
Audio port: D [0, 1024..65534; even values only]”

Video address:
Audio address:

Time to live: [1..255]

DAlways Multicast Video | H.264 W

D Always Multicast Audio

239.247.152.17%

Video paort: D [0, 1024..65534; even values only]”

239.247.152.51

Audio port: [0, 1024..65534; even values only]”

Time to live: \zl [1..255]
DAlways Multicast Video | H.264 W

O

Camera 2

Video address:

Audio address:
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Please give every camera an unique UDP port. If you have more than one Axis main unit, please
make sure every main unit has a unique IP address and for the cameras connected with different Axis
main unit, they should also have different UDP ports.

For example, you have one Axis main unit with IP address 192.168.0.91, another Axis main unit with
IP Address 192.168.1.91, the UDP port setting should be :

e.g. Cameral: IP 192.168.0.91
E PortUDP: 50000
Camera: 1
Camera2: 1P 192.168.0.91
PortUDP: 50001
Camera: 2
Camera3: P 192.168.0.91
PortUDP: 50002
Camera: 3
Camera4: IP 192.168.0.91
PortUDP: 50003
Camera: 4
Camera5: IP 192.168.1.91
PortUDP: 50004
Camera: 1

Please do not use the same UDP port as other cameras, even though they have different
IP addresses.

After input of IP Address, Port TCP/RTSP, Port UDP, Camera Index, Username and Password, you
can click Refresh. The the connection between CANape and Axis main unit should be established.
The parameters under Video Settings should show up automatically. If there is no return value under
Video Setting, it means there is no connection between CANape and the Axis main unit. Please
check your firewall and network configuration again.
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3.5 Create a multimedia window in CANape

B x 1: (New)

=R

-]

[ Explorer Search result

v

AXIS Camera Plug-in Configuration

Calibration windows

Mame/type
[ Devices
> {x) Global variables
4 U cameral

BE cameral
[Tdl Parameter set files
& Measurements

> gl Statistics columns

> [ Function definitions
s Measurement list

> [ Data Mining results
o Configuration (Mew)*
> [ Window templates
1) Deleted windows

3.6 Drag the cameral from symbol explorer and drop it into the multimedia window

orer I x

> [ User-defined filters

& Virtual measurement file chann...

Diagnostic windows
Other windows

Display elements

Page

Meazurement windows

3

3

3

3 Write window
k Trace window
5 Device window

1: (New)

Algerithm Designer

Panel window

GPS window

Model Explorer
Multimedia window
HTML window

TLK StateChart

Scene Window

EE -
:
[l Explorer Search result

Name/type
4 [[3 Devices
5> {x) Global variables
4 Y cameral
> [ User-defined filters
BE cameral
[Tal Parameter set files
[® Measurements
[ Virtual measurement file chann...
> L Statistics columns
> [&l Function definitions
> Measurement list
> Data Mining results
o ] Configuration (Mew)™
> @ Window templates
> ] Deleted windows

ﬁ [1] Multimedia window

SI000m  000m  10.00m
80.00 80.00

E0.00 E0.00

20,00 m 20,00 m

0.00m 000 m 0.00m
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4 FAQ
4.1 | cannot find the option “Vector Axis Network Camera” in device configuration
Did you install the CANape of the correct version? Can you find the following files in the folder:

CANape\Exec\Plugins\Camera\Axis? If not, you need to upgrade your CANape to the correct
version or copy these files into the corresponding folder.

CANape 16:
v Exec » Plugins » Camera » Axis - | +5 | | Search Axis

0 Name Date modified Type Size
%, CameraProperties.dll 10/5/2018 3:04 AM  Application extens... 63 KB
\%| CameraPropertyGrid.dil 10/5/2018 3:04 AM Application extens... 3T KB
% NetworkClient.dll 10/5/2018 3:04 AM  Application extens... 196 KB
|| VCarmeraPlugin.ax 10/5/2018 3:04 AM  AXFile 509 KB
%) WPFLauncher.dll 10/5/2018 3:04 AM  Application extens... 89 KB

From CANape 17:

» Vector » CANapel85P2HF1 > Exect4 > Plugins » Camera > Axis v
Mame Anderungsdatum Typ Groke
| | VCameraPlugin.ax 04.06.2020 11:12 AX-Datei 1.995 KB

4.2 | cannot see the video image in CANape

(1) You can use AXIS Streaming Assistant to check whether you can see the video or not. Click add
new channel and input the address and video port of your camera.

Copyright © 2022 — Vector Informatik GmbH 8
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©, AXIS Streaming Assistant | = B R |
| VS 2)-
o £ -

An update “orthis program is available. Download

MNew video che nels have been found on the networke.  Add...

Channe. . Status Format HTTPS Audio PTZ
* . Add Channel =
Address: 192.168.0.91
Yideo port: 1

] Use secure connection (HTTPS)

[ Hep [ ok ][ Ccancel

- Summary Device
I MName: Haost:
Format: Madel:
Audio: Firmware:
PTZ: Video port:

Then go back to CANape, choose the source “AXIS” for your camera.

B oo T ==
Name: camera_test
Comment:
Video
Source: (@ AXIS F44-Dual_Audio_lnput - Video 1 v [ Properties...
- L. Audio
Please specify the video - -
and audio device settings. Source: ¥ No audio device -
Stream properties
| Grabber
|
\ DirectX
[ Back |[ OK ][ Cancel |[ Help |

(2) If you can see the video through AXIS Streaming Assistant but still no images in CANape through
Vector plug-in, you can open the IP address in your browser, go to the Basic Setup | Users to check
the configuration of your camera. Make sure that the option Enable anonymous viewer login is
activated.

Copyright © 2022 — Vector Informatik GmbH 9
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- Basic Setup Users 0
Instructions User List
1 Users Usar Name User Group -~
2 TCP/IP i root Administrator
3 Date & Time
» 4 Video Stream
» 5 Audio Settings
' Video & Audio
} Live View Config
' Detectors
+ Applications
[ Add... ] [ Modify... ] [ Remove
' Events
' Recordings HTTP/RTSP Password Settings
Allow password type: Encrypted B unencrypted w
Languages
' System Options User Settings
Enable anonymous viewer login (no user name or password required)
About

Enable Basic Setup

o) (e

(3) Please check whether the firewall is off or not. After you connect the Axis camera in CANape and
start a measurement, you can open Wireshark in parallel to check whether there are UDP packets
coming. If you cannot see the UDP packets, it means the UDP might be blocked by a firewall. Please
contact your IT department to turn the firewall off.

i 1. 50.630344 0.0.0.0 255.255.255.255 DHCP 378 DHCP Discover - Transaction ID @xel097a30
1. 53.710221 0.0.0.9 255.255.255.255 DHCP 378 DHCP Discover - Transaction ID 0xel097a30

1. 54.576132 192.1.6.180 192.168.0.90 : s o

1. 54.838844 192.168.0.100 192.168.0.90 RTSP 285 DESCRIBE rtsp://192.168.8.90/axis-media/media.amp?viieocodec=h2644resolution=648x4808c
. 1. 54.840110 192.168.0.90 192.168.0.100 Tce 60 554 » 52829 [ACK] Seq=1 Ack=232 Win=29216 Len=0
| 1. 55.076850 192.168.0.90 192.168.0.100 ey
{ 1. 55.077284 192.168.0.100 192.168.0.90 RTSP 313 SETUP rtsp://192.168.0.90/axis-media/media.amp/trackID=1?videccodec=h264&resolution=64
. 1. 55.077875 192.168.0.90 192.168.0.100 TCP 60 554 + 52829 [ACK] Seq=1003 Ack=491 Win=30272 Len=0
| 1. 55.323028 192.168.0.90 192.168.0.100 RTSP 285 Reply: RTSP/1.@ 200 OK
{ 1. 55.323295 192.168.0.100 192.168.0.99 RTSP 283 PLAY rtsp://192.168.0.90/axis-media/media.amp?videocodec=h &resoluti &
1. 55.323852 192.168.9.90 192.168.0.100 TCP 6@ 554 =+ 52829 [ACK] Seq=1234 Ack=720 Win=30272 Len=@

1. 55.467459 192.168.0.90 192.168.0.100 RTSP 409
1. 55.474100 192.168.8.90 192.168.0.100 UubP 1443 50002 + 20004 Lenw1400
1. 55.474102 192.168.0.90 192.168.0.100 uopP 1443 50002 + 20004 Len=1400

4.3 Axis FAQ

For specific questions related to the Axis cameras you can visit the Axis FAQ:
https://www.axis.com/support/faqg

AXIS F44 Main Unit User Manual
https://www.axis.com/files/manuals/um f44 1503728 en 1607.pdf

5 Contacts

For support related questions please address to the support contact for your country
https://www.vector.com/int/en/company/contacts/support-contact/.
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